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Section 1

Genera Information

This section provides an overview of the Piccolo Xpress chem-
istry analyzer.

1l intendedUse ... .. 1-2
1.2 Universal Precautions ......................... 1-2
13 Introduction ............. ... .. . i 1-3
1.4 Technical Support ..., 1-4
15 SymbolsUsedinLabeling ...................... 1-4
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1.1 Intended Use

The Piccolo Xpress chemistry analyzer provides quantitative in-vitro deter-
minations of clinical chemistry analytesin lithium-heparinized whole
blood, heparinized plasma, or serum.

CAUTION: If the Piccolo Xpress chemistry analyzer is used in any
way other than described in thismanual, the analyzer may
not operate as intended, may produce inaccurate or no
results, and may pose a safety hazard.

Note: Use only Piccolo reagent discs with the Piccolo Xpress chem-
istry analyzer.

1.2 Universal Precautions

Operator health and safety regulations require that Universal Precautions be observed at all timeswhile
handling human blood samples or working with the Piccolo Xpress chemistry analyzer in any way. For
details, see OSHA 29 CFR Part 1910 (* Occupational Safety and Health Sandards” ), Sandard Num-
ber 1910.1030 (“ Toxic and Hazardous Substances. Bloodborne Pathogens’ ), which can be found by
visiting http://www.osha.gov and searching for “1910.1030".

For further guidelines on handling and disposing of hazardous |aboratory wastes, refer to Clinical Lab-
oratory Waste Management; Approved Guideline — Second Edition (GP5-A2), from the Clinical and
Laboratory Standards Institute (formerly NCCLS). This can be found at http://www.clsi.org.
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1.3 Introduction

The Piccolo Xpress chemistry system is compact and easy to transport. The system consists of a porta-
ble analyzer and single-use disposable reagent discs. The analyzer contains the following features and
components:

B avariable-speed motor to spin the reagent disc

B aphotometer to measure analyte concentrations

m  two microprocessors to control testing and analytical functions

m  athermal line printer to print out results

B aWVGA color touchscreen for communicating with the analyzer
B optional data functions for more detailed analysis information

Each reagent disc is self-contained clear plastic, 8 cm in diameter and 2 cm thick, and containing an
aqueous diluent in its center and dry reagent beads in cuvettes around its edge. All blood separation and
sample diluent mixing is performed within the disc itself.

To perform an analysis, the operator needs only to collect a blood sample (lithium-heparinized whole
blood or plasma, serum), place the sample in the reagent disc, put the disc into the analyzer drawer on
the front of the analyzer, and input patient information. When analysisis finished, the results print auto-
matically.

Results are printed on thermal paper with adhesive backing for inclusion within the patient's medical
record. One Ethernet port and five USB ports are provided so data can be sent to an external printer,
computer, memory stick, or laboratory information systems/electronic medical record systems (L1S/
EMR).

The entire analysis requires ~100 UL of sample and is capable of providing resultsin about 12 minutes.

Note: This manual includes a number of analyzer screens and computer screen captures. The
analyzer screens are illustrations only, not exact duplications. All screens represent typi-
cal use and installations, and may differ in some minor details from the screens on your
System.
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1.4 Technical Support

Abaxis Technical Support personnel are trained to answer questions regarding the operation of the Pic-
colo Xpress chemistry analyzer. For technical support, call or contact:

B USA: 1-800-822-2947

m  Europe: techsupport@abaxis.de

1.5 SymbolsUsed in Labeling

The following symbols are found on the back of the analyzer, on the Piccolo Xpress label and above
the connectors.

Symbol Explanation
— Direct current
I N .
Caution
Refer to any accompanying documents.
Biohazard

In accordance with good laboratory practice, all
material from human sources should be considered
potentially infectious, and handled with the same
precautions used with patient specimens. See
“Universal Precautions” on page 1-2.

KI/' USB connection

Network connection
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Sl Setup and

Description

This section describes how to unpack the Piccolo X press ana
lyzer, and how to set it up in a suitable environment. This sec-
tion also introduces the analyzer’s front panel and touchscreen

user interface.

21 Unpacking ... 2-2
2.2 Physical & Environmental Specifications .......... 2-3
2.3 SEUD .o 2-3
2.4 Piccolo Xpress System Description ................ 2-5
2.5 Touchscreenand FrontPanel .................... 2-6
26 Reagent DisCS . .. .o 2-7
2.7 IngtallingaPrinter Paper Roll ................... 2-9
28 AncillaryProducts . .............. ... ... ... 2-10
2.9 Optional ACCESSOIES . ....vvvi it ii i 2-10
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2.1 Unpacking

1. Remove the Piccolo Xpress chemistry analyzer from its shipping carton.

2. Placetheanalyzer on alevel surfacethat isfree of hair, dust, and other contaminants. Do not
place the analyzer near a sunny window or any other heat source.

3. Check the components received with the Piccolo Xpress against the following figure to
make sure everything required to set up the analyzer is included.

Printer

Touchscreen / and cover

Disc drawer
Power cord and

power adapter
Power button

Note: The shipping carton also includes these items, not shown above: a USB cable, Abaxis

Driver CD, Piccolo Xpress Operator's Manual (this manual), warranty card, and Sart-
up kit.

4.  After setup, complete the warranty card and mail it to Abaxiswithin 10 daysto start the war-
ranty period. Customers are placed on the customer mailing list to receive any information
pertaining to the Piccolo X press and ancillary products, such as software upgrades.
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2.2

2.3

Physical & Environmental Specifications

Dimensions

Weight

M ode of operation

Protection against fluid ingress
Altitude

Ambient operating temperature
Humidity

Reaction temperature

Thermal protection rating
Power requirements

Main supply voltage
Transient overvoltages

Pollution

Height: 32.5 cm (12.80 inches)
Width: 14.9 cm (5.87 inches)
Depth: 21.0 cm (8.27 inches)
Anayzer: 5.3 kg (11.6 pounds)
Power adapter: 1.0 kg (2.3 pounds)
Continuous

Ordinary equipment (IPXO)

2000 m (6562 ft)

15-32 °C (59-90 °F), indoor use

8-80% relative humidity noncondensing
37°C (98.6 °F)

70 °C (158 °F)

100-240 volts AC, 5060 Hz or

16 voltsDC, 5.0 A

Main unit: 1.1-0.45 amps, 16 volts DC,
50A

Fluctuations not to exceed £ 10% of the
nominal voltage

Installation Category |1 in accordance with
UL 61010A-1 second edition Annex J

Degree 2 in accordance with IEC 664

Setup

Set up the Piccolo Xpress on a surface that is as follows:

Q Levd

Free of vibration and sudden jolts

Free of hair, dust, and other contaminants

Located in an ambient operating temperature of 15-32 °C (59-90 °F)
Away from sunny windows and all other potential heat sources

U 0000

At least six inches from any wall to provide adequate ventilation and access to the
power connection and USB ports
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Plug the power jack into the analyzer, then
plug the detachable power supply cord into
the power adapter and into a grounded elec-
trical outlet.

CAUTION: To prevent power surges or drain, do

Note:

not plug the analyzer into the same
circuit as a centrifuge or any other
high-current device. Abaxis also rec-
ommends using a suitable surge pro-
tector.

Press the Power button to
turn on the analyzer.

The display then shows the
following:

If the display is blank (shows no message), remove the plug from the power adapter, then
re-insert the plug and press firmly to make sure it seats correctly.

After passing the self test and reaching operating temperature, the
analyzer isready to run the first reagent disc, and displays Analyze.

See “Quality Control Features’ on page 6-1 for details about the
analyzer self test. The analyzer may require additional time to reach
operating temperature.

Check the analyzer date and time to ensure they are correct. See
“Changing Date and Time” on page 4-15 for directions.

The analyzer can be connected to an external computer or printer to
transmit or print patient and control results. See “ Connecting a Com-
puter/Printer” on page 10-1 for instructions.

24
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7.  Referenceranges are preset when the analyzer is shipped from the factory. The range values
can be changed using the Customizing Reference Range feature described in “ Customizing
Reference Ranges’ on page 4-2.

2.4 Piccolo Xpress System Description

The Piccolo Xpress chemistry system consists of a portable ana-
lyzer and disposable single-use reagent discs. Each reagent disc
contains al the reagents needed to perform apanel of testson a
single sample. Be sure to become familiar with the system before
running samples.

The Piccolo Xpress analyzer uses centrifugal and capillary forces
to process heparinized whole blood samples and distribute
diluted plasmato the reaction chambers (cuvettes) in the reagent
disc. Serum and heparinized plasma samples are processed in a
similar manner. The analyzer optically measures the chemical
reactions and cal cul ates analyte concentrations from these mea-
surements and from encoded calibration data contained on the bar
code ring on the reagent disc.

Results are stored in memory, and can be printed using the built-in thermal printer or downloaded to an
external personal computer for data management.

The touchscreen display provides easy communication with the analyzer. The touchscreen shows pro-
cedural instructions, indicates the status of the analyzer, and presents any error messages. For details,
see “ Touchscreen and Front Panel” on page 2-6.

The reagent disc drawer slides out from the front of the analyzer, and transports the reagent disc (see
“Reagent Discs’ on page 2-7) into the analyzer and automatically positionsit for analysis.

The analyzer prints results on adhesive-backed thermal paper tape, through itsinternal printer.

An external power adapter and two power supply cords are provided: one connects the power adapter

to the back of the analyzer, and the other connects the adapter to a surge protector designed for use with
acomputer. The analyzer also has severa USB connectors: use the top USB connector for connecting
to an external computer (see “ Connecting a Computer/Printer” on page 10-1 for details).

The analyzer is easy to carry using the recessed handle incorporated into the top of the unit.
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2.5 Touchscreen and Front Panel

You'll use the analyzer's touchscreen display to operate the analyzer.

Use the on-screen keyboard and numerical keypad to input patient information.

To enter accented letters, select and hold the letter key in the on-screen keyboard, then
select the accented version from the choices that appear.

The left and right arrow touchscreen keys move the display cursor forward or backward
to change a number on the display. The right arrow key ( > ) functions as adash (-
when entering a patient identification number. The left arrow key ( <) functions as a
backspace.

Usetheup ( A ) and down ( V') arrow keysto scroll through a displayed list of items,
or to increase or decrease a displayed value.

Operating functions are available through various icons on the touchscreen, as well as
specific keys that appear on the touchscreen according to the actions performed.

Select Back on the touchscreen to cancel a choice and return to the previous screen, or to
move backward through a series of screens.

Turn the analyzer's power on and off by pressing the Power
button on the front of the instrument.

Note:

The Power button works only when the disc
drawer is closed and contains no reagent disc.

Power

button \

To open or closethe disc drawer, select Analyze or Close on
the touchscreen. Closing adrawer containing a reagent disc
initiates an analysis.

Results for previously analyzed samples can be accessed using the Recall function. See “Recalling
Results” on page 5-1 for instructions.
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25.1 Information Icons

A number of the analyzer’s touchscreen displaysinclude an information icon that you can select to
get additional information about the procedure you're performing.

For example, in the screen that appears when you load a disc, pressing displays these screens out-
lining the basic analysis procedure:

Select Next and Back to move through the information screens, and Exit to close them.

2.6 Reagent Discs
2.6.1 Disc Sructure and Function

All chemistry reactions in the Piccolo Xpress system are performed inside clear plastic reagent discs,
8 cmin diameter and 2 cm thick, specially designed to convert afew drops of whole blood, plasma, or
serum into a panel of test results. Each disc contains all components and reagents needed to perform
one or more tests on asingle sample.

A total of 30 cuvettes are located around the periphery: _
~____—— barcode ring

m  four system cuvettes contain QC reagent
beads for instrument and chemistry quality
control

cuvettes

T sample port

] minimum and maximum absorbance

cuvettes are used for calibration . .
diluent container

B agspecialy designed cuvette detects whether

. sample fill line
sample volume was sufficient

B acuvette verifies that sufficient diluted sample was delivered to the reaction cuvettes
B anempty cuvette captures excess fluids

B 21 cuvettes contain test-specific lyophilized reagent beads
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The bar code ring attached to the top of the reagent disc contains calibration data for the specific
chemistriesin the disc. It also contains the disc identification code, lot number, and expiration date.
The analyzer automatically checks the code and rejects any expired disc. The bar code ring also pro-
tectsthe optical surfaces of the cuvette from fingerprints and debris, and hel ps minimize contamination
of the analyzer by capturing small drops of blood that may be on the disc surface.

The sample port, marked by an arrow pointing to a molded circle on the disc's upper surface, provides
access to the sample chamber. When sufficient sample has been loaded into the sample chamber, the
samplefill line forms between two molded arrows on the disc surface.

A samplediluent is sealed in a container inside the center of the disc. At the beginning of the reaction
cycle, the analyzer opens this container and releases the diluent.

The analyzer separates a lithium-heparinized whole blood sample by centrifugation inside the disc.
Plasma and serum samples are unaffected. Precisely measured quantities of sample and diluent are
delivered to the mixing chamber. Centrifugal and capillary forces then deliver the diluted sample to
the cuvettes, where it dissolves the reagent beads and initiates the chemical reactions. Reaction prod-
ucts in the cuvettes are then measured photometrically.

2.6.2 Disc Sorageand Handling

CAUTION: Discsare fragile—always handle with care. Do not tap discs on the table or work
bench to empty the sample port. Do not use a disk that has been dropped.

Inspect every reagent disc for damage before use. Never use a damaged disc.

B Storeeach reagent disc as described on its label. This keeps the disc's reagents stable
until the expiration date printed on the disc's foil pouch and encoded in its bar code ring.
The analyzer automatically rejects any expired disc.

B Discscan be used directly from the refrigerator (stored at 2—8 °C) without warming.

B Adisccanremainin its sealed pouch at room temperature for a cumulative period of
48 hours. Longer time at room temperature can cause suppression of chemistries and
disc cancellations.

B Donot exposediscs- in or out of their foil pouches - to direct sunlight or to temperatures
above 32 °C (90 °F).

B |nspect the unopened foil pouch for tears and punctures. A torn or damaged pouch can
allow moisture to reach the disc and reduce reagent performance.

m  Openthedisc pouch at the notch on the top right edge of the package.

Note: You must use the disc within 20 minutes of opening its pouch.
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Once the pouch is opened, do not place the disc back in the refrigerator for later use.

Keep discs clean. Handle them only by their edges to avoid smudges on the optical sur-
faces. Use alint-free tissue to remove any spilled blood from disc surfaces.

Optional: Write the patient identification _ _

. . Write patient
number on the disc surface in the space / D here
shown at right. Do not write anywhere else
on the disc, or on the bar code ring.

Hold reagent discs flat after introducing the
sample or control to avoid spillage.

WARNING: BIOHAZARD: USED REAGENT DISCS CONTAIN BODY FLUIDS. FOLLOW GOOD LABO-

2.7

RATORY WORKING PRACTICES. HANDLE ALL USED DISCS AS IF THEY ARE CONTAMI -
NATED WITH HEPATITIS OR OTHER INFECTIOUS DISEASES. CHECK WITH THE
APPROPRIATE STATE AGENCY REGARDING DISPOSAL REGULATIONS. FOR MORE
INFORMATION, SEE “UNIVERSAL PRECAUTIONS” ON PAGE 1-2.

Installing a Printer Paper Rall

Open the printer cover. If the printer contains aroll of
paper, remove it.

Remove the wrapper from the new paper roll, then unroll
several inches of printer paper.

Put the paper roll into the printer so that the paper unrolls
from the bottom of the roll and out towards the front of
the analyzer, as shown.

Make sure several inches of paper extend out of the
printer slot.

Press the cover closed until it locks into place.

Pull gently on the end of the paper until it is taut.
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2.8 Ancillary Products

To order consumables or supplies such as reagent discs, pipettes, tips, printer paper, or control samples,
contact your authorized distributor, or contact Abaxis Customer Service.

Operational Materials Catalog Number
Pipette tips, disposable, pack of 96 Abaxis #500-9007
Mini pipette, 100 ml, gray Abaxis #500-9006
Internal printer paper rolls, box of 6 Abaxis #1100-4410
Fan filter, covered Abaxis #1987-0009

2.9 Optional Accessories

These items can be attached to the analyzer using its USB ports:
m  USB keyboard
B External printers: contact Abaxis Technical Support for specific models

B Barcode scanners. contact Abaxis Technical Support for specific models
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Testing and Results

This section provides general introductory information about
the Piccolo Xpress analyzer, reagent discs, test procedures, and
test results.

3.1 SampleRequirements . .................... ... 3-2
3.2 PreparingtheReagentDisC ..................... 34
3.3 RunningaPatientSample ...................... 3-6
34 CanceingAnalysis ..., 311
SO RESUIS ..ot 311
3.6 Testing ProcedureSummary ................... 3-16
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3.1 Sample Requirements

Note:

The Piccolo Xpress chemistry analyzer accepts lithium-heparinized whole blood,
plasma, or serum samples.

Lithium heparin is the only anticoagulant recommended for use with the Piccolo
Xpress.

When collecting the sample in lithium heparin collection tubes, fill the tube at |east half-
way so the anticoagulant does not become too concentrated in the sample.

If using CLIA '88 Waived reagent discs: only lithium-heparinized whole blood can be
used as a sample.

If performing a Basic Metabolic Panel Plus: only lithium-heparinized plasma or
serum can be used as a sample. Heparinized whole blood cannot be used.

A sample size of 90-120 pL isrequired.

Whol e blood must be analyzed within 60 minutes of collection, or separated into plasma
or serum.

To prevent hemolysis, do not refrigerate or shake whole blood.

Plasma or serum can be stored at room temperature for no longer than 5 hours after cen-
trifugation. If storage for more than 5 hoursis required, refrigerate the sample in the
stoppered tube at 2-8 °C (36-46 °F) for no longer than 48 hours, or storeit at -10 °C for
up to 5 weeksin afreezer with no self-defrost cycle. Under these conditions, there will
be no clinically important changes in most analyte concentrations.

For accurate interpretation of glucose and lipid results, the patient should fast for at least
12 hours before the sample is collected.

WARNING: OPERATOR HEALTH AND SAFETY REGULATIONS REQUIRE THAT UNIVERSAL PRECAU-

TIONS BE OBSERVED AT ALL TIMES WHILE HANDLING HUMAN BLOOD SAMPLES OR
WORKING WITH THE PICCOLO XPRESS CHEMISTRY ANALYZER IN ANY WAY.

FOR DETAILS, PLEASE REFER TO OSHA 29 CFR PART 1910 (* OCCUPATIONAL
SAFETY AND HEALTH STANDARDS" ), STANDARD NUMBER 1910.1030 (“ TOXIC AND
HAZARDOUS SUBSTANCES. BLOODBORNE PATHOGENS” ), WHICH CAN BE FOUND BY
GOING TO HTTP://WWW.OSHA.GOV AND SEARCHING FOR “1910.1030".

WARNING: OPERATORS MUST ALSO BE AWARE OF STATE AND LOCAL OSHA BIOHAZARD REGU-

LATIONS THAT MAY SPECIFY REQUIREMENTS IN ADDITION TO THE FEDERAL REGU-
LATIONS, AND MUST ALSO ENSURE COMPLIANCE PROCEDURES ARE IN PLACE.

3-2
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3.1.1 Test TubeOrder

To prevent contamination, always fill test tubesin this order:
1. Light bluetop: Sodium citrate. Used for coagulation determinations.
2. Gold top: SST tube with clot activator.
3.  Redtop: Serum only, no anticoagulant.
4.  Green top: Lithium heparin. Anticoagulant for chemistry only.
5. Lavender top: EDTA. Anticoagulant for hematology only.

CAUTION: Do not remove a sample from the disc and try to reintroduce it to the disc.
Never place green top tubes in a test-tube rocker.
Sore samples at room temperature, and use within 60 minutes.
EDTA contamination severely affects results, especially Ca and K+.

Use of a sodium heparin tube will falsely elevate Na+ results.

3.1.2 VenipunctureUsing Vacutainer or Syringe

Whol e blood samples must be collected using lithium heparin as the anticoagulant. Excess heparin can
interfere with certain chemistries, and can cause dilution. To prevent this, fill the vacutainer tube at
least halfway with sample, then mix well by gently inverting two or three times.

The following venipuncture methods are avail able:

m  Preferred method: collecting samplesdirectly into a lithium heparin vacutainer
tube (green top). If additional tubeswill be filled, collecting in the following order:
(2) light blue, (2) gold, (3) red, (4) green, (5) lavender. This prevents adverse effects on
results.

B Syringe with no anticoagulants. Draw the sample, remove the needle, remove the tube
top, then immediately add the sample to lithium heparin (green top tube). Gently invert
the tube two or three times to mix.

Note: Do not shake the tube or hemolysis will result.
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3.2 Preparing the Reagent Disc

B See“Reagent Discs’ on page 2-7 for complete information about Piccolo reagent discs,
including handling instructions. Make sure you are thoroughly familiar with thisinfor-
mation before beginning to use the analyzer.

B See“Sample Requirements’ on page 3-2 for sample handling and storage requirements.

CAUTION:  Analysis must begin immediately (no more than 10 minutes) after dispensing the
sample into the reagent disc.

CAUTION: Discsarefragile - always handle with care. Do not tap discs on the table or work
bench to empty the sample port. Do not use a disk that has been dropped.

CAUTION: Inspect every reagent disc for damage before use. Never use a damaged disc.

321 Sep1— Dispensethe Sample

Use amicropipette (one is included with the Piccolo Xpress) or other transfer device to dispense
approximately 100 pL of sampleinto the disc via the sample chamber.

Write patient

/ ID here

CAUTION: Wear powder-free gloves while handling reagent discs or operating the analyzer.
Powder can interfere with the analyzer's optical components.
1.  Fill the sample chamber.

a Using the Piccolo 100 pl volume pipette, firmly attach a new tip to the end of
the pipette.
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With your index finger or thumb, push the pipette button
to the stop position and hold it down for sample pickup.

Immerse the tip 2-3 mm below the surface of the sample,
as shown at right.

Sowly release the button to pick up the sample. Pause,
then remove the pipette from the sample tube.

Make sure there are no air bubbles or air gapsin the pipette
tip.

Place the pipette tip into the disc's sample chamber, and tilt
the disc to 45° with the sample port above thefill line, so
that the entire sample flows into the sample chamber. The
tip should touch the sample chamber, as shown at right.

Push the plunger down with a slow, continuous motion.
Take care not to overfill the sample chamber. A 90 pL sam-
plewill fill the sample chamber and form aline between

the two arrows molded on the disc. More than 120 pL of sample will overfill the

chamber.

K eep the pipette plunger pressed down until the pipette tip is removed from the

sample port.

Discard the pipette tip into a biohazard container.

Clean the reagent disc. Use alint-free tissue to remove any sample spilled on the

outside of the disc, taking care that the tissue does not withdraw any sample
from the sample port. Dispose of the tissue in a biohazard container.

2. Optional: Label the disc. Write the patient ID on the disc surface, in the space as shown on

page 3-4. Do not write anywhere el se on the disc or on the bar code ring.

3.  Carry the prepared disc to the analyzer. Hold the disc by its edges, and make sure keep it

level to avoid spills.

CAUTION:

Do not remove the sample and then try to reintroduce it to the disc.

Testing and Results
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3.3 Running a Patient Sample

This section includes detailed, step-by-step instructions for performing analyses using the Piccolo
Xpress.

Note: The analyzer includes a number of optional data functions that can be used to enter more
detailed information about samples.

In this manual, the steps for these optional functions are marked with the Advanced Set-
tingicon: |
The screens for these optional functions appear on the analyzer only if the functions are
enabled. If a screen shown in a procedure step in this manual does not appear on the
analyzer screen, skip that step. (For details about these functions, see “ Using Optional
Data Functions’ on page 4-29.)

1.  Turnontheanayzer by press-
ing the Power button on the
front of the analyzer. Do this
before removing reagent discs
fromthe refrigerator. — >

The analyzer starts up, then

performs a self test. (For infor-

mation about the analyzer self

test, see “Quality Control Features’ on page 6-1.)

If the analyzer needstimeto
warm the disc chamber to
operating temperature, the dis-
play shows Warming.

When the analyzer reaches
operating temperature, it dis-
plays Analyze on the Home
screen, as shown.
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2.  Select Analyze on the touch-
screen to open the disc drawer.

The messages shown are then
displayed. —
Note: Select the information icon in the Load Disc screen to see an outline of the basic

analysis procedure. Select Next and Back to move through the screens, and Exit to close.

3. Placethediscin the recessed areain the drawer.

4. Select Close. The analyzer then closes the drawer.

5. | Optional: Enter the operator ID, then select Done.

The operator 1D isastring of up to 14 numbers and/or characters.

The right arrow key ( > ) functions as adash (-), and the | eft arrow
key ( <])) functions as a backspace.
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6. Select the sample type from
those shown in the display.

The example figure at |eft
shows the default selections:
Patient and Control. The
choices you see depend on the
analyzer’s configuration — see
“Using Optional Data Func-
tions’ on page 4-29.

Note: The correct sample type is necessary for results to be interpreted correctly.

7. | Optional: Select the patient's gender.

8. | Optional: Enter the patient's age using the up ( A ) and down
( V) arrow keys. Adjust the units as needed, then select
Done.
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9.  Enter an ID number for the sample (up to 14 characters), then select
Done.

10. | Optional: Enter an alternate ID (up to 14 characters), then
select Done.

11. Theanalyzer then checksthe
disc type, and begins process-
ing the sample.

Note: If the disc is an incorrect type or expired, an error appears. Repeat the analysis with an
unexpired disc of the correct type.

12.  When the sampleisfinished processing, the analyzer storesthe
results and shows that the analysisis complete.
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13. By default, the analyzer automatically prints the results of the analysis.

If the results do not print automatically, they can be recalled from memory and printed —
see “ Searching for Results” on page 5-3.

Note: Be sure to check the printout for any suppressed results, marked with these symbols. ~~~

14. Select Open to open the disc
drawer.

15. Remove the reagent disc from the drawer.

WARNING: BIOHAZARD: USED REAGENT DISCS CONTAIN BODY FLUIDS. FOLLOW GOOD LABO-
RATORY WORKING PRACTICES. HANDLE ALL USED DISCS AS IF THEY ARE CONTAMI -
NATED WITH HEPATITIS OR OTHER INFECTIOUS DISEASES. CHECK WITH THE
APPROPRIATE STATE AGENCY REGARDING DISPOSAL REGULATIONS. FOR MORE
INFORMATION, SEE “UNIVERSAL PRECAUTIONS” ON PAGE 1-2.

16. To analyze another sample, insert the new reagent disc and repeat the above procedure.

17. When finished, select Close to close the drawer and return the ana-
lyzer to standby mode.
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3.4 Canceling Analysis

Occasionally you may need to cancel an analysisin progress. Do this as follows.

1. Select Cancel on the touchscreen.

2.  Select Cancel again to con-
firm.

The analysisis then canceled.
and the disc drawer opens. —

3. Removethe disc from the drawer. Select Close to close the drawer.

The analyzer is now ready to perform another analysis.

3.5 Reaults

The results calculated by the analyzer are stored in memory and printed automatically, and can also be
recalled and printed later as needed. If the analyzer is connected to an external computer, the results are
automatically transmitted as soon as they are calculated (see “ Connecting a Computer” on page 10-2).
See “Principles of Operation” on page 8-2 for the basic procedure and equations used to calculate ana
lyte concentrations.
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The figure at the right shows the contents of atypical results printout.
The heading of the results printout includes information such as the
reagent disc type, test date and time, sample type, patient or control 1D
number, alternate ID number, gender, age, operator 1D number, disc lot
number, and analyzer serial number. The test results are printed in four
columns: chemistry name, analyte concentration, reference range, and
specified units, as shown. The results printout has an adhesive backing so
it can easily be placed into the patient'sfile.

Each reagent disc contains reagents to detect exposure to extreme condi-
tions such as temperature and humidity. The message QC OK is printed
on the results when results from these reagents are within the expected
ranges. Otherwise, no results are printed, and the analyzer opens the disc
drawer.

3.5.1 Interpreting Results

Note: As with any diagnostic test procedure, all other test procedures —including the clinical
status of the patient — should be considered prior to final diagnosis.

m  Resultsfaling outside the reference range are indicated in the results by an asterisk (*)

printed next to the analyte concentration.

m  Resultsfaling outside the dynamic range are indicated in the results by aless-than sym-
bol (<) printed next to the lowest value of the dynamic range, or a greater-than symbol

(>) printed next to the highest value of the dynamic range.

For example, the dynamic range of glucoseis 10-700 mg/dL. A sample concentration of
glucose below this range would be printed as <10 mg/dL, and a concentration above this
range would be printed as >700 mg/dL. Results outside the dynamic range should be

reported as being below or above the value indicated.
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Note: If any result for a particular test exceeds the dynamic range, analyze the sample by
another approved test method or send it to a referral laboratory for analysis. Do not
attempt to dilute the sample and re-run it on the analyzer.

Extensive testing of the Piccolo Xpress chemistry analyzer has shown that in very rare
instances, sample dispensed into the reagent disc may not flow smoothly into the sample
chamber, so that an inadequate amount of sample is analyzed. This can cause several
results to unexpectedly fall outside the reference ranges: if this happens, run the sam-
ple using a new reagent disc. For details, see “ Instrument and Result Messages’ on
page 7-2, and especially the table on page 7-3.

m  Thesampleindices are included at the bottom of the results printout. These indices indi-
cate the degree of hemolysis, icterus, and lipemiafound in the sample. Hemolysis,
icterus, and lipemia are measured on a scale of 0 (clear), 1+ (dlight), 2+ (moderate), and
3+ (gross).

3.5.2 Troubleshooting Problem Results

B Thesymbols~~~ are printed in place of numbers when aresult cannot be determined —
that is, when the result is suppressed. A result may be suppressed due to improper mixing
of areagent bead with diluted sample, a nonlinear reaction, an endpoint of a particular
reaction not reached, or a concentration outside the analyzer’s capabilities. When a
chemistry is suppressed (~~~), the analyzer prompts you to print an error report.

B CONFIRM LOW RECOVERIES with an exclamation point (!) next to every analyte indi-
catesthat at least one of the analytes has alower concentration that would normally be
expected. If this occurs, re-run the sample — if the message persists, the sample may be
problematic.

B HEM,LIP, or ICT isprinted in place of the analyte concentration if hemolysis, lipemia, or
icterus, respectively, has adversely affected the results. LIP isalso printed if both lipemia
and icterus have been affected. HEM is also printed if hemolysis and icterus, hemolysis
and lipemia, or hemolysis, lipemia, and icterus have affected a particular analyte. Exam-
ine the sample indices to determine if more than one interferent is affecting a particular
result.
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L actate Dehydrogenase (L D) Assay

Blood cells contain significant levels of LD, and therefore all LD assays are sensitive to
hemolysis caused by release of LD from red blood cells. In the following circumstances,
the results are annotated to help interpret LD activity in the presence of small amounts of
hemolysis.

If HEM is greater than 50 and less than or equal to 100 mg/dL, the printed LD valueis
followed by an H, indicating additional influence from hemolysis.

If HEM is greater than 100 and less than or equal to 150 mg/dL, the LD valueis pre-
ceded by < and followed by H, indicating that the true LD recovery isless than reported.

If HEM is greater than 150, no result will be indicated, and only HEM will be printed.

Endogenous Substances

The analyzer judges the quality of each sample, and measures spectrophotometrically the concentra-
tions of endogenous substances for each run. The levels of Hemolysis (HEM), Lipemia (LIP), and
Icterus (ICT) are indicated at the bottom of each result tape or on the touchscreen.

Levelsare scored as O, 1+, 2+, or 3+ depending on levels of each interferent. The following table
shows the relationship between these scores and the approximate concentration of each endogenous
substance in the sample.

Correlation of Sample Index vs Endogenous Substance Concentration

Endogenous Substance
Index Concentration (mg/dL)
HEM 0 <20
1+ =220to <45
2+ =245t0<181
3+ > 181
LIP 0 <150
1+ =150 and < 221
2+ 2221 and <301
3+ > 301
ICT 0 <2.8
1+ >228and <55
2+ 255and<10.5
3+ >10.5
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The effects of endogenous substances have been characterized for each of the Abaxis analyte test meth-
ods and cut-off levels have been set for each. The result will be automatically suppressed, and in its
place HEM, ICT, or LIP will beindicated if the test results will be negatively affected. The table below
lists the concentration above which an analyte might be negatively affected.

Endogenous Substance Cut-off for Abaxis Analyte Test Methods

HEM LIP ICT
Analyte (mg/dL) | (mg/dL) | (mg/dL)
ALB 2580 4200 37
ALP 1000 1600 37
ALT 1300 2200 17
AMY 1300 1600 26
AST 430 1436 17
BUN 2580 4200 37
CA 2000 1500 26
CHOL 1400 3900 25
CK 1000 1600 42
CL- 1300 2000 34
CRE 688 3000 7

DBIL 200 600 N/A
GGT 1300 1600 26
GLU 1790 750 37
HDL 400 1000 17
LD 150 1720 64
K+ 300 2000 17
MG 1000 1500 38
NA 2000 2600 25
PHOS 400 1100 42

TBIL 420 1500 N/A
TCO2 1300 2200 17
TP 2580 1000 14
TRIG 750 1000 42
UA 1100 1500 6.5

If the sampleisidentified as hemoalytic, collect a new sample and run another reagent disc. Abaxis rec-
ommends that the new sample be separated into serum or plasmaso that the degree of hemolysis can be
verified. If the new sampleis hemolytic, use an aternative testing method or send the sample to arefer-
ence laboratory. Samples with hematocrit in excess of 60% packed red cell volume may appear on the
result card as HEM. Follow the instructions above for retesting hemolyzed samples.
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High lipemiamay be due to diet. Ensure the patient has fasted for at least 12 hours before collecting
another sample. For suggestions on testing grossly lipemic or icteric samples, see” Troubleshooting”
on page 7-1. For grossly lipemic samples from fasting patients or for icteric samples, use an alternative
testing method or send the sample to areference laboratory.

3.6 Testing Procedure Summary

3.6.1

3.6.2

Piccolo Xpress Chemistry Analyzer

Make sure the electrical outlet used for the analyzer is grounded.

Make sure the ambient temperature in the analyzer’s location is 15-32 °C (5990 °F).
Do not disconnect the power to the analyzer while running a sample.

Keep the analyzer drawer closed when not in use.

Do not attempt to repair the analyzer, as this may void the warranty.

O See“Troubleshooting” on page 7-1 for troubleshooting procedures.
O See“Maintenance and Service” on page 9-1 for regular maintenance tasks.

Reagent Discs

CAUTION: Discsare fragile—always handle with care. Do not tap discs on the table or work

bench to empty the sample port. Do not use a disk that has been dropped.

Inspect every reagent disc for damage before use. Never use a damaged disc.
Do not use expired discs. The reagent disc expiration date is printed on the foil pouch
and is encoded in the bar code.

Store all reagent discs at 2—8 °C (36—46 °F) as described on their respective pouch labels.
Discs may be used directly from the refrigerator.

Keep reagent discs clean. Use powder-free glovesto handle the discs, and touch the discs
only along their edges to eliminate the possibility of fingerprints on the cuvette optical
surfaces. If sample spills on the outside of the disc, remove it with alint-free tissue, and
make sure the tissue does not withdraw any sample from the sample port.

After introducing the sample, hold the reagent disc flat to avoid spillage.
Never use areagent disc that has been dropped.
Use the reagent disc within 20 minutes of opening the foil pouch.

Run the reagent disc within 10 minutes of applying the sample.
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3.6.3 Samples

m  Anayze whole blood samples within 60 minutes of collection.

m  Fill the lithium heparin specimen collection tube at least half-way to ensure the sample
does not have a high concentration of anticoagul ant.

m  To prevent hemolysis, do not refrigerate or shake whole blood samples.

®m  When adding blood to evacuated collection tubes, remove the needle from the syringe
and the stopper from the tube, and gently place the sampleinto the tube. (If sampleis
injected through the stopper, hemolysis may occur.)

CAUTION: Do not remove a sample from the disc and then try to reintroduce it into the disc.

Note: Always fill evacuated collection tubesin this order:

1. Light bluetop: Sodium citrate. Used for coagulation determinations.
Gold top: SST tube with clot activator.
Red top: Serum only, no anticoagulant.

Green top: Lithium heparin. Anticoagulant for chemistry only.

o M 0D

Lavender top: EDTA. Anticoagulant for hematology only.
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el Al Configuring the

Analyzer

This section describes how to configure the Piccolo Xpress
chemistry analyzer to achieve excellent performance.

Here are the main analysis tasks:

B Review “Using the Settings Screen” on page 4-2 to see
how to adjust the analyzer’s settings.

® Change reference ranges to be specific to the patient
population, and print, transmit, or archive these ranges.
O “Customizing Reference Ranges’ on page 4-2
O “Printing and Archiving Reference Ranges’ on
page 4-11
Q “Transmitting Reference Ranges’ on page 4-13
B Adjust the analyzer’'s general settings as needed:

U

“Viewing Analyzer Information” on page 4-15

“Changing Date and Time” on page 4-15

“Selecting the Language” on page 4-16

“Selecting Units” on page 4-17

“Setting Sound Volumes® on page 4-21

“Adjusting the Display” on page 4-22

“Printer Settings’ on page 4-24

“ Setting Communication Protocol” on page 4-28

“Using Optional Data Functions’ on page 4-29

“Security Settings’ on page 4-34

B Run control samples: see “Running Controls’ on
page 4-31.

O U000 00D O

Note: When available, you can select the information
icon for additional help.
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4.1

Using the Settings Screen

The following shows the general path through the analyzer’s menus for performing the proceduresin
this section. These procedures are available whenever the analyzer displays the Home screen.

1.

4.2

In the Home screen, select the Settingsicon.

oan

The Analyzer Settings screen then appears. From here, you can adjust the date and time, lan-
guage, sound, display, and printer, or view basic information about the analyzer.

Select the More Settings icon. )
e
@
This opens the second Analyzer Settings screen. Use this screen as a starting point to make

additional settings, work with reference ranges, and update the analyzer’s software.

Select Home to return to the analyzer’s Home screen.

Customizing Reference Ranges

The Piccolo X press includes a number of factory-set analyte and demographic reference ranges for use
in analysis. You can modify these ranges as needed, as well as create or remove custom ranges, or
return all factory rangesto their default settings.

Note:

When modifying references ranges, change the ranges in either Common unitsor S
units, not both. The analyzer automatically converts units.

In the Home screen, select the Settingsicon.

oan

Select the More Settingsicon.

oan

Select the Reference Range Settings icon.

I-.d- — .—
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4. IntheInclude Reference Ranges screen, select the reference range
to modify:
O To modify the last reference range that was changed, select
Last Modified, then skip to step 5 on page 4-4.

O To modify any reference range, select All, then continue with
the next step below.

5.  TheModify Reference Range screen then opens. From here, the fol-
lowing procedures are available:

O Modify the reference ranges for a specific analyte — see
below.

O Modify the reference ranges for a particular demographic —
see page 4-5.

O Add areference range for a new demographic — see page 4-6.

(M

Remove areference range for a demographic — see page 4-9.

O Restore all factory reference ranges to their default values —
see page 4-10.

4.2.1 Modifying Reference Rangesfor an Analyte

Change the reference ranges for a specific analyte as follows.

1. Inthe Modify Reference Range screen, select Analyte.
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In the Analyte screen, select the analyte.

Usetheup ( A ) and down ( V') arrow keys to scroll through the
list.

Select the patient’s gender.

Select the reference range to modify.

Usetheup ( A ) and down ( V') arrow keys to scroll through the
list.

Use the controls to set the upper and lower limits for the range.
O Usetheup (A ) anddown (V) arrow keysto adjust the val-
Ues.
O Select Clear to set both limits to zero.
O Select Default to use the factory default values for the range.

Select Save to store the changes.
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4.2.2

1.

M odifying the Reference Ranges for a Demographic

Use this procedure to modify the reference ranges for a particular demographic, patient type,

or control.

In the Modify Reference Range screen, select Demographic.

In the Demographics screen, choose the patient or control demo-
graphic to modify.

Usetheup ( A ) and down ( V') arrow keys as needed to scroll
through the list.

Patient demographic only: select the gender.
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4.  Theanayzer then displays the ranges for
the patient or control demographic.

Select the analyte to adjust. If needed, use
theup ( A ) and down ( V' ) arrow keysto
scroll through the list.

5.  Usethe controlsto set the upper
and lower limits for the range.

O Usetheup (A )and
down ( V) arrow keysto

adjust the values. —

O Select Clear to set both
limits to zero.

O Select Default to use the
factory default values for
the range.

6. Select Save to store the changes.

4.2.3 Adding a Demographic

Use this procedure to add reference ranges for a particular demographic.

1. Inthe Modify Reference Range screen, select Demographic.
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2. Inthe Demographics screen, select Add Demographic.

O To create areference range for a new, unnamed demographic:
a. Select Special #.

Note: The displayed number # depends on the number of special or
control level demographics already added or deleted.

b. Select the gender.

c. Selecttheanalyteto adjust. If needed, usetheup ( A ) and
down ( V') arrow keysto scroll through the list.
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d. Usetheup ( A ) anddown (V) arrow keysto set upper
and lower limits for the analyte.

B Sdect Clear to set both limitsto zero.
B Select Default to use the factory default values.

Note: Entering zero for both values suppresses printing of the ranges
for thisanalyte in results (blanks appear instead), and also sup-
presses checking the recovered value against the range limits.

e. Select Save to store the changes.

Q To create anew control:
a. Select Control #.

b. Select the analyte to adjust from the list. Usetheup ( A )
and down ( V') arrow keysto scroll through the list.

c. Usetheup (A ) anddown (V) arrow keysto set upper
and lower limitsfor the analyte.

B Select Clear to set both limits to zero.
B Seclect Default to use the factory preset values.

Note: Entering zero for both values suppresses printing of the ranges
for this analyte in results (blanks appear instead), and also sup-
presses checking the recovered value against the range limits.

d. Select Save to store the changes.
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4.2.4 Removing a Demographic

Use this procedure to remove the reference ranges for a particular demographic.

1. Inthe Modify Reference Range screen, select Demographic.

2. Inthe Demographics screen, select Remove Demographic.

3.  Select the demographic to remove. Usetheup ( A ) and down ( V)
arrow keysto scroll through the list.

4.  When the warning screen appears, select Continue to permanently
remove the demographic.
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4.25 Restoring Factory Default Demographics

Use this procedure to restore al factory reference ranges to their default settings.

1. Inthe Modify Reference Range screen, select Demographic.

2. Inthe Demographics screen, select Factory Default Demograph-
ics.

3. Sdect Yes.
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4.3 Printing and Archiving Reference Ranges

Reference ranges can be printed, or stored in the analyzer as archive files for later use or review.

1. Inthe Home screen, select the Settingsicon.

oGn

2. Select the More Settings icon.

e8n

3.  Select the Archive Reference Rangesicon.

4. Sedlect Send.

O To archive the reference ranges into the analyzer'sinternal
memory: select Internal Archive.

The reference range is then stored in the analyzer under the
current date and time.

Note: See“ Retrieving Reference Ranges’ on page 4-12 for instruc-
tions on retrieving stored archives.

O To archive the ranges onto a PC connected to the analyzer, see “ Transmitting Refer-
ence Ranges’ on page 4-13.

(See " Connecting a Computer” on page 10-2 for instructions on connecting a PC to the
analyzer.)
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O To print arange or ranges:
a. Select Printer.
b. Select the report type
to print (the left dia-

gram shows the
default choices, the

right shows typical —_—
customized choices).

All printscontrolsand
patients.

c. Thereference range (or ranges) is then printed.

4.4 Retrieving Reference Ranges

Reference ranges can be retrieved from archives as follows.

Note: Retrieving an archived reference range overwrites all reference range values currently in
the analyzer. Consider archiving the current reference ranges before retrieving another
Set.

1. Inthe Home screen, select the Settingsicon.

oan

2.  Select the More Settingsicon.

aoan

3. Select the Archive Reference Ranges icon.
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4. Sdlect Retrieve.

5. Select thearchiveto retrieve. Usetheup ( A ) and down ( V')
arrow keys as needed to scroll through the list.

6.  When awarning screen appears, select Continue to retrieve the
archived reference range.

4.5 Transmitting Reference Ranges

Reference ranges can be transmitted to a connected PC and stored for later use or review.

1. Inthe Home screen, select the Settings icon.

(1Y

2. Select the More Settings icon.

aoen
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3. Select the Archive Reference Ranges icon.

4. Select Send.

5. Sdect External Archive.

6. Select thereport type (thetype
of ranges) to send to the PC.

The reference range is then sent to the PC and stored under the current date and time.

Note: See “ Retrieving Reference Ranges’ on page 4-12 for instructions on retrieving stored
archives.
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4.6 Viewing Analyzer Information

Use this function to verify information about the analyzer, such asits serial number, the version of the
installed software, and information about the tests that have been run and printed.

1. Inthe Home screen, select the Settingsicon.

°en

2. Select the Analyzer Information icon.

3.  Thedisplay then shows the analyzer information.

4.7 Changing Dateand Time

The date and time is factory preset to Pacific Time. Verify the date and time when the analyzer is
removed from its shipping carton.

1. Inthe Home screen, select the Settings icon.

°an

2.  Sdect the Date and Timeicon. —~
(~°
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3. Inthe Set Time screen, use the controls to set thetime:

O Usetheup (A ) anddown (V) arrow keysto adjust the
hour and minutes.

Q Sdlect 12/24 to switch between 12- and 24-hour time formats.
Q Select Zero Sec to set the seconds to zero.
4.  Select Date to save.

Note: If thetime entered isinvalid, an error message appears— select
Continue, set the correct time, then select Done.

5. Inthe Set Date screen, use the up and down arrow keysto adjust the
day, month, and year.

6. Sdect Done to save.

Note: If the date entered isinvalid, an error message appears— select
Continue, the set the correct date.

4.8 Selecting the Language

The analyzer provides several languages for menus, the keyboard, and printing (English USA isthe
default). Select the language to use as follows.

1. Inthe Home screen, select the Settingsicon.

oan

2. Select the Languagesicon.
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3.  Select thedisplay language from thelist. If needed, usetheup ( A )
and down ( V') arrow keysto view the entire list.

4.  Select the keyboard type from the list. Use the arrow keys to scroll
through the list.

Note: The selected keyboard affects all keyboards and barcode scan-
ners connected to the analyzer’s USB ports.

Note: To add accented letters, select and hold the |etter key in the on-

screen keyboard, then select the accented version from the
choices that appear.

49 Seecting Units

Use this procedure to set the units used by the analyzer and in results: Common units (mg/dL, etc.) or
Sl units (Systeme Internationa) (mmol/L, etc.).

1. Inthe Home screen, select the Settingsicon.

oan

2. Select the More Settings icon.

aoan

3.  Select the Units Settingsicon.

g
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4.  Settheunitsused for al analytes, aparticular analyte, or agroup of analytes as follows.

O To set unitsfor al analytes:
a. Select All Analytes.

b. Select the unitsto use for al analytes: Non SI or SI.

O To set unitsfor aparticular analyte:
a. Select Single Analyte.
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b. Select the analyte from thelist.

If needed, usetheup ( A ) and down ( V') arrow keysto
view the entire list

c. Select the unitsto use for the anayte: g/dL, g/L, mg/dL,
mg/L, or umol/L.

O To set unitsfor agroup of analytes (electrolytes, enzymes, lipids, minerals, or pro-
teins):

a. Select Analyte Groups.
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b. Select to select an analyte group: Electrolytes, Enzymes,
Lipids, Minerals, or Proteins.

m For electrolytes: select mmol/L or mEq/L.

B For enzymes: select U/L or ukat/L.

m For lipids: select mg/dL or mmol/L.
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B For minerals: select mg/dL, mmol/L, or mEq/L.

m For proteins: select g/dL or g/L.

4.10 Setting Sound Volumes

Adjust the volume of the analyzer's screen click, aert, and status notification sounds as follows.

1. Inthe Home screen, select the Settingsicon.

odn

2. Select the Sound Settingsicon.

3.  Select the sound to adjust.
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4. Usethe controlsto set the selected volume.

O Usetheup ( A ) anddown (V) arrow keysto adjust the vol-
ume.

O Select Off to turn the sound off.

O Select Default to set the sound to its factory default value.

5.  Select Save to store the new setting.

4.11 Adjusting the Display

The brightness of the analyzer's display can be adjusted as needed, and the display’s touchscreen can be
calibrated for best performance. In addition, the time the analyzer must be inactive before it activates a
screen saver or enters power-saving mode can be set as required. (For either, touch the screen to wake
the analyzer.)

1. Inthe Home screen, select the Settingsicon.

o8N

2. Select the Display Settingsicon.

3. Adjust or calibrate the display asfollows:

O To adjust the backlight brightness:
a. Select Backlight.
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b. Usethe controlsto set the brightness:

m Usetheup (A ) and down ( V) arrow keysto
adjust the brightness level.

B Select Full to select maximum brightness.

B Select Default to set the brightness to its factory
default.

c. Select Save to store the new setting.

O To adjust the screen saver delay:

a Sdlect Screen Saver.

b. Usethe controlsto set the delay:

m Usetheup (A ) and down ( V) arrow keysto
adjust the delay.

B Select Never to turn off the screen saver.

B Select Default to set the delay to its factory default.

c. Select Save to store the new setting.
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O To adjust power-saving delay:

a Select Power Save.

b. Usethe controlsto set the delay:

m Usetheup ( A ) anddown (V) arrow keysto
adjust the delay.

B Seclect Never to prevent the analyzer from entering
power-saving mode.

B Select Default to set the delay to its factory default.

C. Select Save to store the new setting.

4.12 Printer Settings

Use the procedures in these pages to set up and configure the analyzer's internal printer, or an external
printer connected to the analyzer.

1. Inthe Home screen, select the Settingsicon.

oan

2. Select the Printer Settingsicon.
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3.  ThePrinter Setup screen then opens.

O To select the default printer to be used with the analyzer, see
“ Setting the Default Printer,” below.

O Totest aprinter for proper function, see “ Testing a Printer” on
page 4-26.

O To select which reports can be printed automatically after an
analysis, see“ Selecting Reports’ on page 4-27.

4.12.1 Setting the Default Printer

Select the default printer for results and reports as follows.

1. Inthe Printer Setup screen, select Configure.

2.  Sdect Set Default.
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3.  Select the Analyzer Printer or an External Printer.

4. External Printer only: select the printer from the displayed list of available printers. The
analyzer then automatically detects the type of printer and configuresit as needed.

4.12.2 Testing a Printer

Test the function of the analyzer's printer or a connected external printer as follows.

1. Inthe Printer Setup screen, select Test.

2. Select the printer to test.

The selected printer then prints a test page.
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4.12.3 Selecting Reports

Use this procedure to set the type and number of reports that can be printed automatically after a sam-
pleisanayzed.

1. Inthe Printer Setup screen, select Configure.

2. Select Select Reports.

3. Select the report type.
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4.  Usethe controlsto set the number of copiesto print:

O Usetheup (A ) anddown (V) arrow keysto adjust the
number.

O Select Clear to set the number to zero.

O Select Default to set the delay to its factory default.

5.  Select Save to store the new setting.

4.13 Setting Communication Protocol

To transmit results and other information from the analyzer to an external computer, specify the com-
munication protocol to be used.

1. Inthe Home screen, select the Settingsicon.

Y

2. Select the More Settings icon.

oan

3.  Select the Communication Settingsicon.

4.  Select aprotocol: None, ASCII Text, ASTM 1394-97, or XML.
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4.14 Using Optional Data Functions

The Piccolo Xpress includes a number of optional data-entry functions that can be used to enter more

detailed information about samples, such as age and gender. The analyzer can be configured to use
some or al of these functions as needed.

Note: The analyzer includes a number of optional data functions that can be used
to enter more detailed information about samples.

In this manual, the steps for these optional functions are marked with the
Advanced Setting icon: |

The screens for these optional functions appear on the analyzer only if the
functions are enabled. If a screen shown in a procedure step in this manual
does not appear on the analyzer screen, skip that step.

1. Inthe Home screen, select the Settingsicon.

°en

2. Select the More Settings icon.

aoan

3. Select the Advanced Settingsicon.

4.  Select Data Entry Options.
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5.  Inthe Advanced Settings screen, select the types of information that
will be needed during analysis.

6. AlternatelD only: select an aternate ID item to be entered (such as
Doctor ID, Phone #, DOB, Admission ID, or Patient ID).

Usetheup ( A ) and down ( V) arrow keys as needed to scroll
through the list.

7.  Enablethe eGFR calculation (see “eGFR X press Operation” on page 4-31) asfollows:

a. Inthe Home screen, select the Settingsicon.

oan

b. Select the More Settingsicon.

oan

C. Select the Advanced Settings icon.

d. Select Analyte Options.
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e. Sdect eGFR.

eGFR Xpress Operation

eGFR (estimated Glomerular Filtration Rate) is turned off by default, and is enabled in the Advanced
Settings screen (see step 7, above) under Analyte Options.

When eGFR is enabled, choosing Patient sample type prompts you for Age, Race and Gender when-
ever adisc includes CRE. The analyzer requires information for these three itemsto perform the calcu-
lations: if no information or “unknown” is entered, the displayed result for eGFR will be N/C and an
error report is printed automatically.”

When eGFR is off, eGFR shows aresult of N/C (Not Calculated) on the results printout, directly below
CRE (creatinine).

The official units for eGFR are mL/min/1.73 m?. The analyzer uses mL/min to enable smpler printing.

4.15 Running Controls

A control isabiological sample or solution with a suitably contrived matrix that is analyzed for pur-
poses of quality control. The composition of the matrix must be such that the solution closely matches
that of the biological specimen for characteristics of importance to the analyzer. Control materials need
to be stable and available in sufficient volumes in multiple portions and over an extended period. Many
control products are available commercially. Assayed controls also come with expected values of the
analytes for guidance.

Abaxis recommends control testing as follows:
B atleast every 30 days
m  whenever laboratory conditions have changed significantly
®  whentraining or retraining of personnel is indicated
B when test results do not match patient symptoms or clinical findings

m  with each new lot (CLIA waived tests in waived status labs)
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Good laboratory practices include the recording of the QC data according to the laboratory's estab-
lished written procedures. A permanent record of control results should be retained.

Samples and controls are run identically by the analyzer. However, using the Run Controls option in
the Menu function stores control results separately from patient results in the analyzer memory. Con-
trol results can be printed on aresult card immediately after the conclusion of the control run, or when-
ever the control run results are recalled. (See “ Recalling Results from the Last Disc Run” on page 5-2
for details.) Control results are automatically transmitted to a linked computer.

Handle the control as described in the control package insert. Call Abaxis Technical support for assis-
tance in interpreting control results.

The analyzer automatically stores control results in amemory separate from the patient results mem-
ory. The Recall function can be used to search for specific control results without searching through all
patient results stored in memory.

Note: Before a control can be run, a control level must be enabled in the reference ranges —
see” To create a new control:” on page 4-8.

Controls can be run whenever the analyzer displays the Home screen.
Note: For more details on running controls, see “ Preparing the Reagent Disc” on page 3-4.

CAUTION: Discsare fragile—always handle with care. Do not tap discs on the table or work
bench to empty the sample port. Do not use a disk that has been dropped.

Inspect every reagent disc for damage before use. Never use a damaged disc.

1. Inthe Home screen, select Analyze to open the disc drawer.
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2. Placethediscin the drawer, then select Close to close the drawer.

Analysis then begins automatically.

3. L~ Optional: enter the Operator ID, then select Done.

The right arrow key ( > ) functions as adash (-), and the left arrow
key ( <]) functions as a backspace.

The operator 1D is up to 14 characters.

4.  Select the control type to use.

Usetheup ( A ) and down ( V') arrow
keys as needed to scroll through the list.

Theleft screen showsthe default: Control.
The screen at right shows custom entries.

5. Enter asampleID (up to 14 characters), then select Done.

Configuring the Analyzer 4-33



6. Theanalyzer then checksthe
disc type, and then begins pro-
cessing the sample with no fur-
ther input.

7.  When the sampleis finished processing, the analyzer shows that the
analysisis complete, and automatically prints the results of the anal-
ySiS.

If the results do not print automatically, they can be recalled from
memory and printed — see “ Searching for Results’ on page 5-3.

8.  Sedlect Open to open the disc drawer, and remove the reagent disc from the drawer.
CAUTION: Dispose of the used reagent disc according to the lab's biohazard procedures.

9. When finished, select Close to close the drawer.

4.16 Security Settings

Use Security Settings to enable various access levels on the analyzer.

B Administrators can access al of the analyzer’s settings screens. When this setting is
enabled, security features take effect when the first administrator is added, and are dis-
abled if all administrators are deleted. When security is enabled, accessing the second set
of settings screensrequires avalid Administrator ID and password.

CAUTION: Record all Administrators IDs in a safe place. If an Administrator 1D islogt, the ana-
lyzer must be returned to Abaxis for recovery.
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B Operatorsare authorized to operate the analyzer. Once an operator is added, the Opera-
tor ID prompt appears whenever analyzing a sample.

Note: A warning appears if an operator is not authorized, or the operator 1D needsto be
renewed.
Note: The analyzer can store up to 100 administrators and 100 operators.

B Controls sets a date by which anew set of control samples must be run. If new controls
are not run by this date, awarning appears whenever a sample is analyzed.

1. Inthe Home screen, select the Settingsicon.

(1Y

2. Select the More Settings icon.

e8n

3.  Select the Security Settingsicon.

4.  Select the appropriate security option.

Configuring the Analyzer 4-35



4-36 Configuring the Analyzer



Section 5

Recalling Results

The Piccolo Xpress chemistry analyzer includes a Recall func-
tion that provides access to the most recent test results, includ-
ing patient results, control results, and test errors.

The Recall function is available from the analyzer’s Home
screen.

You can search results by patient/control 1D number or date, or
view patient results or control results by date. You can also view
the results in memory one record at atime, and then print the
results or transmit them to a computer.

Note: The analyzer must be connected to a computer to trans-
mit results. For instructions, see“ Connecting a Com-
puter” on page 10-2.

This section includes instructions for recalling, viewing, and
printing or transmitting results and reports.

5.1 TroubleshootingFlags.......................... 5-2
5.2 Recalling ResultsfromtheLast DiscRun .......... 5-2
5.3 SearchingforResults........................... 5-3
54 BrowsngResults ............... i 5-8
5.5 TransmittingAll Results . ....................... 5-9
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5.1 Troubleshooting Flags

The Piccolo Xpress performs a series of internal quality checks to ensure accurate results. When the
analyzer detects a problem, it either suppresses certain chemistry results (in which case it prints trou-
bleshooting “flags” — such as ~~~, HEM, LIP, or ICT — in place of values), or cancels the run (the

disc cancels and no results are printed).

When either of these occurs, you can print or transmit an error report as described in the following sec-
tion.

5.2 Recalling Resultsfrom the Last Disc Run

You can recall, print, or transmit the results of the last disc run, as follows.

1. Inthe Home screen, select the Recall icon.

2. Sdect Last Disc.

3.  Theresults from the last disc are displayed. Usetheup ( A ) and
down ( V') arrow keysto scroll through the results.
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4.  To print these results or transmit them to an external computer,
select Print:

a  Sdect Print or Transmit.

b. Select thereport: All, Results, iQC, or Error Report.

Note: If the disc produced no results, only Error Report will be avail-
able.

The display then shows Sending Report... while the report or results
are being printed or transmitted.

5.3 Searchingfor Results

Use the Recall function to search for a particular record according to its patient/control 1D number or
date, or to view alist of all saved patient or control results sorted by date.

1. Inthe Home screen, select the Recall icon. __a
Note: If the analyzer contains no saved results, it displays the message No saved results to view.

2. Sdect Search.

3.  Usethe Search screen to search for results. See the following:

O “Searching for Results by Patient/Control ID” on page 5-4
O “Searching for Results by Date” on page 5-5

O “Viewing Patient Results or Control Results by Date” on
page 5-7
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5.3.1 Searching for Results by Patient/Control ID

1. In the Search screen, select Patient/Control ID.

2. Enter the patient/control ID number.

Use theright arrow key (> ) to enter dashes (-), and the Ieft arrow
key (1) to backspace.

3. Sdect Search.

The analyzer then displays alist of results (Patient, Control, and
Error) sorted first by patient/control ID, then by date. Any samples
with the ID number entered will be at the top, followed by the next-
closest matches.

Usetheup ( A ) and down ( V') arrow keys to scroll through the
list. (The list wraps around when either end is reached.)
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4.  Select the resultsto display.

Usetheup ( A ) and down ( V) arrow keysto scroll through the
list.

5. To print these results or transmit them to an external computer,
select Print:

a.  Select Print or Transmit.
b. Select thereport: All, Results, iQC, or Error Report.

The display then shows Sending Report... while the report or results
are being printed or transmitted.

5.3.2 Searching for Results by Date

1. In the Search screen, select Date.

2. Usetheup (A ) anddown (V) arrow keysto enter the date of the
results to search for.
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Select Search.

The analyzer then displays alist of resultsin reverse chronological
order, beginning with the date entered.

Usetheup ( A ) and down ( V') arrow keys to scroll through the
list.

Select the results to display.

Usetheup ( A ) and down ( V') arrow keys to scroll through the
list.

To print these results or transmit them to an external computer,
select Print:

a.  Select Print or Transmit.
b. Select thereport: All, Results, iQC, or Error Report.

The display then shows Sending Report... while the report or results
are being printed or transmitted.
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5.3.3 Viewing Patient Resultsor Control Results by Date

1. Inthe Search screen, select Patients or Controls.

The analyzer then displays alist of
patient results (P) and errors (E), or
control results (C) and errors (E), in
reverse chronological order from the
date entered.

Usetheup ( A ) and down ( V) arrow
keysto scroll through the list.

2. Select theresultsto display.

Usetheup ( A ) and down ( V') arrow keys to scroll through the
results.

3. To print these results or transmit them to an external computer,
select Print:

a. Select Print or Transmit.
b. Select thereport: All, Results, iQC, or Error Report.

The display then shows Sending Report... while the report or results
are being printed or transmitted.
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5.4 Browsing Results

Use the Recall function to browse through all stored results.

1. Inthe Home screen, select the Recall icon.

2. Sdlect Browse.

The analyzer then displays alist of al results (Patient, Control, and
Error) in reverse chronological order from the date entered.

Usetheup ( A ) and down ( V') arrow keys to scroll through the
list.

3.  Select theresultsto display.

Usetheup ( A ) and down ( V') arrow keys to scroll through the
results.
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4.  To print these results or transmit them to an external computer,
select Print:

a.  Select Print or Transmit.
b. Select thereport: All, Results, iQC, or Error Report.

The display then shows Sending Report... while the report or results
are being printed or transmitted.

5.5 Transmitting All Results

Use this procedure to transmit all stored results to a connected computer.

Note: The analyzer must be connected to a computer to transmit results. For instructions, see
“ Connecting a Computer” on page 10-2.

1. IntheHome screen, select the Recall icon.

2. Sdect Transmit All.

The analyzer displays Transmitting All... while the records are being
sent.
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Section 6

Calibration and
Quality Control

6.1 Calibration

The Piccolo Xpress chemistry analyzer is self-calibrating. The
bar code on each reagent disc contains information used to cali-
brate the analyzer when the disc isrun. In addition, each reagent
bead in the disc is calibrated to a reference method and/or refer-
ence material. The procedures in the previous sections use these
features to keep the analyzer calibrated and its results accurate.

6.2 Quality Control Features

The Piccolo Xpressincludes quality control features such as
optical sensing and electronic feedback to ensure accurate
results. The analyzer runs a self test on its components and the
reagent discs whenever power isturned on or areagent discis
inserted, and continues testing during analysis. Messages on the
display or in the result printout warn of any malfunction or pos-
sible error, or explain why no results are reported.

6.2.1 Inteligent Quality Control (iQC)

The Piccolo Xpress performs an iQC test when power is turned
on. iQC ensures that components are functioning properly, and if
so, then verifies memory functions. Any component malfunction
results in a message on the display.

The analyzer software uses statistical methods to ensure accurate
results. The lamp flashes up to 13 times for rate chemistries, and
typically three times for endpoint chemistries. The distribution
of flashesis analyzed, and the standard deviation is compared to
apre-determined limit to make sure the analyzer is functioning

properly.
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6.2.2 Quality Control During Analysis

During analysis, the analyzer checks its components and the reagent disc to ensure accurate results.

Piccolo Xpress Analyzer
Before analysis begins, the analyzer’s photometer takes readings with the light path obstructed and also
unobstructed, to determine the appropriate light intensity range, then makes sure the range is within
specification. It also continually checks the performance of the motor, flash, and optics during analysis.
Reagent Disc
The analyzer checks the reagent disc during anaysis to confirm the following:
m  calibration factors
expiration date
presence of all reagent beads
timing of fluid movement through the disc
diluent and sample mixing

sufficient sample in the disc

proper dissolution of the reagent beads when mixed with sample

Each reagent disc also contains reagents to detect exposure to extreme conditions such as temperature
and humidity. The message QC OK appears in the printout when results from these reagents are within
the expected ranges. Otherwise, no results are printed, and run canceled appears on the display.

The analyzer also monitors reaction performance. For rate chemistries, the analyzer confirms that the
reactions are linear with time and slope is within range, and monitors substrate depletion. In endpoint
chemistries, the analyzer verifies the flatness (completeness) of the endpoints.

Sample

Samples are checked for physical interference. The analyzer estimates the sample indices, hemolysis,
lipemia, and icterus using absorbance readings for the sample at 340 nm, 405 nm, and 467 nm, then
compares them to pre-established limits for each method. When all three indices are below the method
limits, the result for that method is printed on the result card. If even one index exceeds the limit, the
result for the method is suppressed and the error condition displayed as HEM, LIP, or ICT.

6.3 Running External Controls

The Run Controls menu function automatically stores control results in a memory separate from the
patient results memory (see “Running Controls” on page 4-31). The Recall function may be used to
search for specific control results without searching through all patient results stored in memory.
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Section 7

Troubleshooting

7.1 Error Messages

The analyzer can display warning and error messages when
problems occur. These messages include an internal error code
that will assist Abaxis Technical Support in diagnosing the prob-
lem. Record the error message and/or print an error report before
calling Abaxis Technical Support.

7.2 Electrostatic Discharge

If the analyzer experiences an electrostatic discharge while run-
ning asample, it may “freeze up.” If this happens, cancel the
analysis (see “ Canceling Analysis’ on page 3-11), then power
the analyzer off and back on again. This should restore the ana-
lyzer to operating condition.

7.3 Technical Support

If the troubl eshooting recommendations contained in this section
do not correct the problem with the analyzer or the reagent discs,
please contact Abaxis Technical Support:

Abaxis Inc.

m  call 800-822-2947
B email medtechsupport@abaxis.com

B send afax to 877-349-2087

Abaxis Europe GmbH
m  cal +49(6151) 350 79-0
B email techsupport@abaxis.de

m  sendafax to +49 (6151) 350 79-11
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7.4 Disc Cancedlations

If the disc cancels, record the following information or print an error report and contact Abaxis Techni-
cal Support:

] Lot number
] Product name
m  4-digit error code

B Specimen type and sample

7.5 Instrument and Result M essages

The Piccolo Xpress chemistry analyzer performs a series of internal quality checks to ensure accurate
results. When the analyzer detects a problem, the analyzer will either suppress certain chemistry results
(~~~, HEM, LIP, or ICT printed in place of values) or cancel the run (disc cancels and no patient results
printed). When either of these situations occur, the operator should proceed as described below.

751 Chemistry Suppression

In this situation, patient results print, but some results do not have numerical values. Instead, the results
include troubleshooting flags ~~~, HEM, LIP, or ICT printed in place of values.

If this happens, record the error code, print an error report using the Recall function (see “Recalling
Results’” on page 5-1), and contact Abaxis Technical Support to review the error report.

75.2 Disc Cancdlation

In this situation, the display shows Run Canceled and does not print patient results. The display also
shows an error code and a brief description of the error.

If this happens, record the error code, print an error report using the Recall function (see “Recalling
Results’ on page 5-1), and contact Abaxis Technical Support to review the error report.
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7.5.3

Symbols on the Results Printout

The following table explains the symbols that may appear on the results printout.

Symbols printed next to theresult (see “ Running a Patient Sample” on page 3-6)
Symbol Meaning Notes

* The result is outside the reference range. An asterisk (*) is printed next to the analyte
concentration if the results are outside the
range. An asterisk is also printed if the result
is at the upper or lower limit of the range, but
because results are rounded, these are
considered out-of-range as well. For
example:
Na+ 145* (128-145)
a - 98* (98-108)

< The result is lower than the dynamic range. For more information on results with < or >

> The result is higher than the dynamic range. printed before the value, print an error report
(see “Recalling Results” on page 5-1). This
report includes patient results, but the values
approximate the analyte concentration.

H After an LD value, indicates that hemolysis might
affect the results.

<andH If < appears before and H after an LD result,
hemolysis is more extensive (100-150 mg/dL) and
the true LD value is less than reported.

C The result was calculated.

! Confirm Low Recoveries. This indicates at least Re-run the sample. If the message recurs,
one analyte has a lower concentration than results may fit patient profile clinically, or the
normally expected. sample may be problematic.

N/C Not Calculated.
Symbols (flags) printed instead of results
Symbol Meaning Notes
~~~ Chemistry interference See “Results” on page 3-11.
HEM Hemolysis interference
LIP Lipemia interference
ICT Icterus interference

The entire numerical line displayed on the error report, including the line HEM (H), LIP (L), and ICT
(1), must be interpreted by a Technical Support Representative. Call Abaxis Technical Support.
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7.6 Raenitializing the Analyzer

If the analyzer requires reinitialization, use the reinitialization function to return all settings to their
original factory default values (including the clock), and also to clear all patient results, control results,
and custom reference ranges from memory. Perform the following steps to reinitialize the analyzer.

1. Inthe Home screen, select the Settingsicon.

oan

2. Select the More Settings icon.

oan

3. Select the Factory Settingsicon. | T
2o

4.  Archivethe analyzer’sreference ranges— including custom reference ranges — so they can
be restored after the analyzer isreinitialized. For instructions, see “Printing and Archiving
Reference Ranges’ on page 4-11.

CAUTION: Thenext stepisirreversible. All settings—including custom reference ranges—are
returned to their factory values, and the memory is cleared. Results previously stored,
however, are not affected.

5. Select YES torestore al factory settings (including the clock) and
to clear al memory from the analyzer.

6. Refer to the following sections to reset any custom reference ranges, the date and time, or the
units of measurement:
O “Customizing Reference Ranges’ on page 4-2
Q “Changing Date and Time” on page 4-15
Q “Selecting Units’ on page 4-17

7-4 Troubleshooting



Section 8

Operating Principles

8.1 Principlesof Procedure

The operator introduces a heparinized whole blood sample (or
heparinized plasma, serum, or control) into the reagent disc. The
reagent disc contains a diluent and test-specific reagent beads.
The operator then places the disc in the Piccolo X press chemis-
try analyzer and enters the appropriate identification numbers.
The analyzer automatically performs the remainder of the test-
ing protocol.

The reagent disc spins and whole blood is separated into plasma
and blood cells. During thistime, the disc is heated to 37 °C
(98.6 °F). Precisely measured quantities of plasma and diluent
enter the mixing chamber and are mixed together. Through cen-
trifugal and capillary forces, the diluted plasmais distributed to
cuvettes on the perimeter of the disc. Reagent beadsin the
cuvettes are dissolved by the diluted plasma. This solution is
thoroughly mixed and the resulting chemical reactions are mon-
itored photometrically by the analyzer. Optical signals gener-
ated by the chemical reactions are used to calculate analyte
concentrations. Calibration data specific for the chemistriesin
each disc are provided to the analyzer by the bar code printed on
the bar code ring.

After the analysisis completed, the results print automatically.
Analyte concentrations and reference ranges for each test in the
panel and sampleindices areincluded on a printout, providing a
paper copy of the results. Results are also stored in the ana-
lyzer’s memory and can be transmitted to external computers.
The used reagent disc is removed and discarded.

The Piccolo Xpressis then ready to analyze another sample.
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8.2 Principlesof Operation

Chemical reactions occur between reagent beads, the diluent contained in the reagent disc, and the
added sample. These reactions produce chromophores that are measured photometrically by the Pic-
colo Xpress. The microprocessor then cal culates the concentrations of the analytes.

The measurement optics include a stroboscopic xenon lamp, a wavelength selection system, and a
multiple-wavelength detector. Light from the lamp is directed by a mirror to pass through each
cuvette. Some light is absorbed by the cuvette contents and the remainder travels through two aper-
tures and is then collimated by alens. Collimated light is split by beam splitters and interference fil-
ters at pre-determined wavelengths (340, 405, 467, 500, 515, 550, 600, 630, and 850 nm), and
captured at each wavelength by photodiodes.

The chemical reactions utilized in the tests are designed to produce chromophores that absorb light at
known wavelengths. The photometer measures light that is transmitted through a chromophore-con-

taining cuvette (the reaction cuvette). The transmitted light, when corrected for flash-to-flash variabil-
ity and electronic offset, isindirectly related to the analyte concentration of the sample. Transmittance
measurements are converted to absorbance using the relationship: absorbance = - og (transmittance).

System errors and factors that may interfere with sample result calculations are eliminated by measur-
ing light intensity at four locations of the reagent disc: the method-specific cuvette containing test
reagent, sample, and diluent; the sample blank cuvette containing sample blank reagent, sample, and
diluent (used in endpoint reactions, see below); the open cuvette, which allows all the light to pass
through; and the dark cuvette, which blocks the passage of light.

Light passing through a reaction cuvette is measured both at the wavelength that is absorbed by the
chromophore (I;;rc) and at awavelength not absorbed by the chromophore (1 orc). Theratio of these
two measurements corrects for cuvette optical quality and flash-to-flash variability in the light source.
Theintensity of light transmitted through the open cuvette (1) 10¢, Io0c) 1S Measured at the same two
wavelengths as the light transmitted through the reaction cuvette. A correction for electronic offset is
made at the same two wavel engths by measuring the residual signal when the dark cuvetteisin the

optical path (110, I120)-
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The equation for calculating absorbanceis:

where;

Thisis the basic equation to measure analyte concentrations in the rate methods and endpoint reac-

A

Ivre
Iore
I7»10
I7»20
lx10c

lr20c

Absorbance at wavelength 1, referenced to wavelength 2

Intensity of light transmitted through the reaction cuvette at wavelength 1
Intensity of light transmitted through the reaction cuvette at wavelength 2
Intensity of light transmitted through the dark cuvette at wavelength 1
Intensity of light transmitted through the dark cuvette at wavelength 2
Intensity of light transmitted through the open cuvette at wavelength 1
Intensity of light transmitted through the open cuvette at wavelength 2

tions used in chemistries.

821

Therate of the reaction is calculated from the difference between absorbances measured at certain
defined intervals on the linear portion of the reaction curve. Absorbances are taken throughout the

Rate M ethods

read time to confirm the linearity of the reaction curve. The absorbance rates are converted to anayte

concentrations by using the disc-specific calibration factors that are encoded on the bar code ring.

The equation for rate methodsiis:

where;

AAIAT

Iaxx

Rate of change of absorbance

M easurements taken at time F on linear portion of reaction curve
M easurements taken at time B on linear portion of reaction curve
Time in minutes

Other intensities as described above
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8.2.2 Endpoint Reactions

Reagents, samples, and chromophores all absorb light in endpoint reactions. Light absorption by the
samples must be subtracted so that the analyte concentration can be isolated. The absorbance of the
sample is measured in a sample blank cuvette. Some chemistries employ a generic sample blank and
others (such astotal bilirubin) use a dedicated sample blank. The intensity of the light passing through
the sample blank cuvette (1) 15c, hosc) IS measured at the same wavelengths as is the light passing
through the reaction cuvette.

The equation for endpoint reactionsis:

where:
lhisc = Intensity of light transmitted through the sample blank cuvette at wavelength 1
lhosc = Intensity of light transmitted through the sample blank cuvette at wavelength 2
lhxx = Other intensities as described above

The net absorbance is converted to analyte concentration using data encoded in the bar code printed
on the bar code ring.
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Section 9

M aintenance and
Service

The Piccolo X press chemistry analyzer requires minimal mainte-
nance. Clean the exterior of the analyzer weekly with mild deter-
gent and a soft, damp cloth. The air filter requires cleaning twice
per year. Regular maintenance of the analyzer will help assure
reliable operation, depending on the environment.

CAUTION:  Abaxis recommends only the cleaning methods
described in this section. If for some reason
another method is needed, contact Abaxis
Technical Support beforehand to verify that the
proposed method will not damage the analyzer.
Abaxisis not responsiblefor damage caused by
non-recommended cleaning methods.

9.1 Cleaningthe Analyzer

Clean the analyzer’s external case and display at least weekly.
Inspect the instrument casing during cleaning to ensureit isfree
of damage or cracks.

9.1.1 CleaningtheCase

Clean the analyzer with a soft cloth, dampened with a mild, non-
abrasive detergent or cleaning solution, such as Simple Green®,
a 10% bleach solution, or a 30% isopropyl acohol solution. Pre-
soaked towel ettes (isopropyl acohol) may be used as an alter-
nate. Purchase isopropyl towelettes from computer retailers.

Do not spray or pour any detergents, solutions or other liquids
directly onto the analyzer. Dampen a soft cloth or disposable
paper towel with the detergent, then apply to the analyzer.
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9.1.2 Cleaningthe Display

Clean the analyzer’s screen periodically using a soft, lint-free cloth dampened with a glass-cleaning
fluid or window cleaner. The screen can be disinfected using a 10% bleach solution: apply the solution
to alint-free cloth, then wipe the screen.

CAUTION: Do not use any cleaner containing alcohol. Do not spray cleaner directly onto the
display — dampen the cloth instead.

9.2 Cleaning Spills

Observe universal precautions! when cleaning spills on the analyzer. Use a 10% bleach solution (1 part
bleach plus 9 parts water) to clean spills, following the standard cleaning guidelinesin “Cleaning the
Analyzer” on page 9-1.

Note: For further guidelines on handling and disposing of hazardous laboratory wastes, refer
to“ Clinical Laboratory Waste Management; Approved Guideline—Second Edition”
(GP5-A2), from the Clinical and Laboratory Sandards Institute (formerly NCCLS). See
http: //mmwwwww.clsi.org.

9.3 CleaningtheAir Filter

Theair filter in the back of the analyzer should be cleaned at |east twice per year. Check the air filter
more often than twice per year if the analyzer islocated in an environment with excessive dust or dirt.

To clean the air filter:

1.  Unplug the anayzer and remove the power cord from the
back of the analyzer.

2. Grasp the black mesh filter in the circular opening and
removeit.

3. Wash thefilter in warm soapy water and dry completely.

4. Placetheclean, dry filter flat in the circular opening and
push the sides of thefilter behind the edges of the circular
opening.

5. Plug the power cord into the back of the analyzer.

1. Clinical and Laboratory Standards Institute (formerly NCCLS). 2005. Protection of Laboratory Workers from Occupationally
Acquired Infections; Approved Guideline—3rd Edition (M29-A3). Wayne, PA: CLSI; pp 29-31. Clinical and Laboratory Standards
Ingtitute (formerly NCCLS). 2002. Clinical Laboratory Waste Management; Approved Guideline—2nd Edition (GP5-A2). Wayne,
PA: CLSI.
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6.  Plug the power cord into the power source, and press the Power button on the front of the
analyzer. The analyzer will perform adiagnostic self test. It may take up to another four min-
utes for the heaters to bring the analyzer disc chamber to operating temperature.

Refer to “ Troubleshooting” on page 7-1 if the analyzer does not successfully pass the self test. See
“Running a Patient Sample” on page 3-6 to run samples.

9.4 Updating the Analyzer Software

Software updates for the analyzer are provided by Abaxis to registered owners of the Piccolo Xpress
chemistry analyzer, in CD-ROM format. Replacement software is mailed immediately whenever anew
software version is released. See“Viewing Analyzer Information” on page 4-15 to determine the soft-
ware version installed in the analyzer. Contact Abaxis Technical Support immediately if the software
version is not the most recent release.

Note: Be sure to update the software every time an update CD is received from Abaxis.

Update the analyzer software as follows:

1. Inthe Home screen, select the Settings icon.

o8N

2. Select the More Settings icon.

e8n

3.  Select the Software Update icon.

4. Placethe CD in the drawer, press the drawer closed, then select
Continue.
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5. The software update then begins.

When the update is complete, the analyzer automatically restarts.

CAUTION: Do not remove the CD or remove power until after the ana-
lyzer shuts down and restarts to compl ete the software
update, or you could damage the analyzer.

9.5 Returningthe Analyzer to Abaxisfor Service

The Piccolo Xpress must be shipped in an authorized shipping container. Authorization for shipping
and servicing the analyzer must be obtained from Abaxis Technical Support before sending the ana-

lyzer.

To obtain authorization for service on the analyzer, call Abaxis Technical Support.

Note: All patient data is erased when an analyzer is serviced. Before sending in your analyzer,
be sure to back up all patient records. For instructions, see “ Transmitting All Results”
on page 5-9.
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Section 10

Connecting a
Computer/Printer

This section describes how to connect a printer or computer to
the Piccolo X press, how to install the needed driver software,
and how to capture test results from the analyzer on a Windows
PC using HyperTerminal.

10.1 Connecting an External Printer ................ 10-2
10.2 ConnectingaComputer ..............ccoivnn.. 10-2
10.3 Transmission Specifications ................... 10-2
10.4 Ingtalling the AbaxisDriver ................... 10-3
10.5 Capturing Resultswith HyperTerminal .......... 10-9
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10.1 Connecting an External Printer

You can print results from the Piccolo X press using any USB-compatible external printer approved by
Abaxis. For alist of approved printers, call Abaxis Technical Support at 800-822-2947 (for Europe,
contact techsupport@abaxis.de).

Connect the printer as described in the printer's instructions. See “ Printer Settings’ on page 4-24 for
configuration instructions.

10.2 Connecting a Computer

The Piccolo X press analyzer is equipped to transmit patient and control resultsin multiple formatsto a
computer through the analyzer’s USB serial port. To receive the results from the Piccolo X press, the
computer requires terminal emulation software (such as HyperTerminal, included with Windows 95
through Windows XP) and driver software to communicate with the Piccolo Xpress.

Abaxis can also provide data files for interfacing with an LISEMR system. Contact Abaxis Technical
Support for details.

Test results can be saved to atext file for viewing with word processing, spreadsheet, and database
applications. This section describes the transmission specifications and hardware connections, and
using HyperTerminal to capture resultsto atext file.

Note: Data management systems can be interfaced with the Piccolo Xpress to collect analysis
results. Snce the installation for each type of data management system differs, please
contact your data management system supplier for more information.

10.3 Transmission Specifications

Cable USB cable

Baud rate 9600

Datatype ASCII

Parity None

Word length 8 bits

Sop bit 1

Sart of transmission and new page | Form Feed (decimal 12 or hexadecimal 0C)

sentinel

End of line sentinel Carriage Return (decimal 13 or hexadecimal 0D) and Line Feed
(decimal 10 or hexadecimal 0A)

End of transmission sentinel End-of-File (decimal 26 or hexadecimal 1A)

Max number characterdline 30 (including Carriage Return and Line Feed)

Max number lines 26
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Note: The exact contents of the printout are transmitted. In some cases a backslash (\ ) should
be interpreted as a foreslash (/). For example, “ mmo\L” is equivalent to
“mmol/L”, and “ mmo\L” is“ mmol/L” in the transmitted results.

10.4 Installing the Abaxis Driver

This section describes how to install a software driver that enables the Piccolo X press analyzer to com-
municate with a Windows, Linux, or Macintosh computer. The analyzer installs on the computer asa
virtual communication port in the operating system.

10.4.1 Installing on a Windows PC

Installing the driver on a Windows PC requires the following:
B Piccolo Xpress analyzer
m  PC with Windows operating system and afree USB port
m  TypeA/TypeB USB cable
m  AbaxisDriver CD (P/N 1100-7019)

Note: Driver installation in Windows may require a user account with administrative privileges.

The screenshots in these instructions are from a typical Windows XP Professional installa-
tion. Some of these screens may vary in other versions of Windows.

Install the driver as follows.

Note: Do not connect the analyzer to the PC or turn the analyzer on until specifically directed to
do so.
1.  TurnonthePC, and insert the Abaxis Driver CD into the PC's CD drive.

2. Connect the USB cable to a Type A connector on the PC and to the uppermost USB connec-
tor (Type B) on the back of the analyzer.

3. Turnonthe analyzer. Wait for the PC to recognize the analyzer and start the Found New
Hardware Wizard — this may take afew minutes.
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4. If thewizard asksto connect to Win-
dows Update, select No, not this
time, then click Next.

5. SelectInstall from alist or
specific location, then
click Next.

6. Select Search for the best
driver in these locations, then
check Include this location in
the search.

7.  Click Browse, then navigate to
the PC’'s CD drive containing the
Abaxis Driver CD.

8. Onthedrive, select the correct
folder for the PC's version of
Windows;

Q For Windows 2000, XP,
Vista, or 7: select the Win2K _XP folder.

Q For Windows 98 or ME: select the Win98_ME folder.
9. Click Next.

10. If awarning states that the software has not passed the Windows L ogo testing, click Con-
tinue Anyway.

The wizard then copies files from the CD to the PC.
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11. When thisdialog opens, click
Finish.

12. After amoment, the Found New
Hardware Wizard starts again. If the
wizard asks to connect to Windows
Update, select No, not this time,
then click Next.

13. Sdlect Install from a list or
specific location, then
click Next.
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14. Select Search for the best
driver in these locations, then
check Include this location in
the search.

15. Click Browse, then navigate to
the PC’s CD drive containing the
Abaxis Driver CD.

16. Onthedrive, select the correct
folder for the PC’s version of
Windows;

O For Windows 2000, XP, or
7: select the Win2K _XP folder.

Q For Windows 98 or ME: select the Win98_ME folder.
17. Click Next.

18. If awarning states that the software has not passed the Windows L ogo testing, click Con-
tinue Anyway.

The wizard then copiesfiles from the CD to the PC.

19. When this dialog opens, click
Finish.
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20. Open the Windows Device Manager:

Q For Windows 2000, XP, Vista, or 7: click Start > Control Panel > Hardware and
Sound > Device Manager.

Q For Windows 98 or ME: click Start > Control Panel > Performance and Mainte-
nance > System. Click the Hardware tab, then click Device Manager.

21. InDevice Manager, click the + before
Ports (COM & LPT).

22. Record the port to which the analyzer
was assigned (COM4 in the figure at
right). You will need thislater to capture
test results.

10.4.2 Installingon aLinux PC

Connecting the Piccolo Xpress to a PC running the Linux operating system requires the following:

B Piccolo Xpress analyzer
m  PCwith Linux (kernel version 2.4 and above) and a free USB port
B TypeA/TypeB USB cable

Note: Thedriver isincluded in Linux kernd version 2.4 and above, but must be enabled to use.

Enable the driver asfollows.

Note: Do not connect the analyzer to the PC or turn the analyzer on until specifically directed to
do so.

1. TurnonthePC, andloginasroot.

2. Connect the USB cable to a Type A connector on the PC and to the uppermost USB connec-
tor (Type B) on the back of the analyzer.

3. Turnonthe analyzer.

4.  Open aterminal window on the PC, and enter the command modprobe ftdi_sio to enable
the driver.

5.  Configure any PC applications (such as minicom) to communicate with the analyzer over the
virtual communication port (such as /dev/ttyS0).
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10.4.3

Installing on a M acintosh Computer (OS X only)

Installing the driver on a Macintosh computer running system OS X requires the following:

Note:

Piccolo Xpress anayzer

Macintosh computer with Mac OS X and afree USB port
Type A/Type B USB cable

Abaxis Driver CD (P/N 1100-7019)

The screenshots in these instructions are from a typical Mac OS X installation. Some of
these screens may vary in other versions of Mac OS X.

Install the driver asfollows.

Note: Do not connect the analyzer to the computer or turn the analyzer on until specifically
directed to do so.
1.  Turnonthe computer, and insert the Abaxis Driver CD into the computer’s CD drive.
2. IntheFinder, go to the CD drive and run the driver installer:
O For an Intel-based Macintosh: open the Mac\Intel folder and run the file
FTDIUSBSerialDriver_vX_X_X.dmg.
O For aPower PC-based M acintosh: open the Mac\PPC folder and run thefile
FTDIUSBSerialDriver_vX_X_ X.dmg.
3.  Follow the instructions that appear on the screen, and restart the computer when prompted.
4.  Connect the USB cableto a Type A connector on the computer and to the uppermost USB
connector (Type B) on the back of the analyzer.
5. Turnonthe analyzer.
6. GotoApplications > System Preferences > Network
to enable the virtual communications port. Click OK.
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7.  Select Network Port Configurations from
the Show list.

8.  Check the On box for the new port, then
click Apply Now.

9.  Asneeded, configure the computer’s applications to communicate with the analyzer using
the new virtual communication port.

10.5 Capturing Resultswith Hyper Terminal
10.5.1 Setting Up Hyper Terminal

This section describes how to set up and use Windows HyperTerminal to capture and transmit analyzer
test results.

Note: The screen captures and menu configurations shown here may vary depending on your
version of Windows.

1.  From the Windows desktop, click
Start > Programs > Accessories >
Communications > HyperTerminal >
HyperTrm.exe to start the HyperTer-
minal setup wizard.

Note: If Hyper Terminal is not present,
install it by going to Start >
Settings > Control Panel > Add/Remove Programs (Add/Remove Windows
Components > Communications tab). Consult Windows help for details.
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2. Typeadescriptive name (such as Abaxis) for the connection,
then click OK.

3.  Usethe Connect using menu to select the port that the analyzer is
connected to, which you recorded previously (see page 10-7),
then click OK. The other settings are not required.

Note: If the port is unknown, select any port. If needed, you can run
the wizard again to try other ports.

4. Inthe port’s Properties dialog, change Bits per second to 9600,
then click OK.

5. If avalid port was selected, a new
HyperTerminal session will start.
The status pane on the lower left cor-
ner of the window should display
Connected as shown.

D

Note: If an error message appears, close Hyper Terminal without saving changes. Run the
Hyper Terminal setup wizard again, and choose a different port.

6. Click File > Save As on the menu to save the HyperTerminal session. Note where the ses-
sion fileis saved so that it can be loaded in the future (create a shortcut on the desktop if nec-
essary). Proceed to the next section for instructions on capturing results.
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10.5.2 Running Hyper Ter minal

1.

Note:

Prepare HyperTerminal to capture results by loading a saved session file or by creating a new
session file as described in “ Capturing Results with HyperTerminal” on page 10-9.

Click Transfer > Capture Text on the menu. Select
or typein apath and file name, then click Start.

Any results transmitted to the computer from this
point forward will be captured in the designated text file.

Transmit results to the computer
following the instructionsin
“Transmitting All Results’ on
page 5-9. The results will appear
in the HyperTermina window, as
shown in this example. In addi-
tion, the results can be manually
copied and pasted into other appli-
cations by highlighting the results
and using the Edit menu.

If the results do not appear in the Hyper Terminal window, an incorrect port may have
been selected in setup. Repeat the setup and select a different port as described in “ Cap-
turing Results with HyperTerminal” on page 10-9.

After the results are transmitted, select Transfer > Capture Text > Stop in the menu. The
captured text file can be used by most word processing, spreadsheet, and database applica-
tions.

Close HyperTerminal by selecting File > Exit in the menu.
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